
 

 

VIDEO (Part 4) 
 
 
 
A. TEORI dan PRAKTEK 

 

Audio Treatment 

 
Adobe Premiere Pro mendukung berbagai format file audio, yaitu format AIFF, AVI, MOV, MP3, 

WAV, dan WMA. Pada bab ini akan dibahas berbagai teknik untuk mengolah audio dalam Adobe 

Premiere Pro. 

 

1. Mengatur Audio Gain  
Untuk mengatur audio gain/volume pada clip audio caranya : 

 
1. Klik kanan pada clip yang terdapat dalam Track Audio 1 pada Timeline Window. Maka 

akan tampil pop‐up menu. Kemudian pada pop‐up menu pilih Audio Gain.  
 
 
 
 
 
 
 
 
 
 
 

 
Tampilan pop-up menu pada clip audio 

 
 

2. Selanjutnya akan tampil kotak dialog Clip Gain. Atur volume‐nya dalam satuan dB 
(desibel). Lalu klik OK. 



 

 

 
 
 
 
 
 
 
 
 
 
 

 
Kotak dialog Clip Gain 

 

3. Untuk mengembalikan audio gain pilih Normalize pada posisi normal 0 dB. 
 
 
2. Keyframing pada Audio Gain 

Parameter audio gain dapat dianimasikan untuk menghasilkan efek Fade-In dan Fade-Out. 

Berikut ini langkah-langkahnya : 
 

1. Pilih clip audio yang ada dalam Timeline Window pada Track Audio 1. 
 

2. Klik tombol Show Keyframes dalam Track Audio 1, sehingga akan tampil pop‐up menu.  
Kemudian pada pop‐up menu pilih Show Clip Volume.  

 
 
 
 
 
 
 
 
 
 
 

 

3. Sehingga tampilan clip audio dalam Track Audio 1 akan menjadi seperti di bawah ini.  
 
 
 
 
 
 
 
 
 
 
 
 

 

4. Untuk membuat efek Fade‐In caranya, geser Current Time Marker ke posisi 00:00:00:00. 
Kemudian buka Tab Effect Controls yang berada dalam Source Monitor Window. 
Selanjutnya expand pilihan Volume yang terdapat dalam Audio Effects. 



 

 

 
 
 
 
 
 
 
 
 
 
 

 

5. Lalu klik tombol Add/Remove Keyframes  yang berada dalam pilihan Level untuk 

membuat keyframe. Selanjutnya ubah nilai Level menjadi ‐00 dB, atau geser play head 

Level hingga pojok sebelah kiri.  
 
 
 
 
 
 
 
 
 
 
 
 

6. Sehingga tampilan clip audio pada Track Audio 1 akan tampak seperti pada gambar di 

bawah ini. 
 
 
 
 

 
Tampilan clip audio dalam Track Audio 1 setelah mengalami perubahan nilai Level 

 
 

7. Setelah itu geser Current Time Marker ke posisi waktu 00:00:04:00. 
 

8. Kemudian klik tombol Add/Remove Keyframes pada pilihan Level untuk membuat 

keyframe. Selanjutnya ubah nilai Level menjadi 00 dB. 
 
 
 
 
 
 
 
 

 

Pembuatan keyframe dan perubahan nilai Level dalam Tab Effect Controls  
 
 
 
 

 

Tampilan clip audio setelah dibuat keyframe dan perubahan nilai Level pada posisi 00:00:04:00 



 

 

9. Sedangkan untuk membuat efek Fade‐Out caranya, geser Current Time Marker ke 
posisi 00:00:10:00. Lalu klik tombol Add/Remove Keyframe yang ada pada pilihan Level 
untuk membuat keyframe.  

 
 
 
 
 
 
 
 
 

 

Tampilan clip audio pada posisi 00:00:10:00 
 
 

10. Lalu geser Current Time Marker ke posisi 00:00:20:00, atau di ujung kanan clip audio. 
 

11. Setelah itu klik tombol Add/Remove Keyframe pada pilihan Level untuk membuat 
keyframe. Kemudian ubah nilai Level menjadi ‐00 dB.  

 
 
 
 
 
 
 
 

 

Tampilan perubahan nilai Level pada posisi 00:00:20:00 
 
 

12. Maka tampilan clip audio pada posisi 00:00:20:00 akan tampak seperti berikut.  
 
 
 

 

Tampilan clip audio pada posisi 00:00:20:00 
 
 

3. Merekam Audio Analog  
Adobe Premiere Pro telah menyediakan fasilitas perekaman audio analog, jadi kita tidak perlu 
menggunakan software lain untuk merekam audio analog. Berikut ini langkah-langkahnya : 

 
1. Tancapkan jack microphone ke dalam port sound input pada Sound Card. 

 
2. Kemudian setting audio hardware menggunakan pilihan Edit > Preferences > Audio 

Hardware. 
 

3. Maka akan tampil kotak dialog Preferences, apabila sound card terinstal dengan baik 
maka nama driver sound card akan tertera disini. Lalu klik OK. 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan kotak dialog Preferences 
 
 

4. Lalu pada menu pilih Window > Workspace > Audio. Sehingga tampilan Adobe Premiere 

Pro akan tampak seperti pada gambar berikut ini. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan Workspace Audio 
 
 

5. Kemudian klik tombol Enable track for recording  yang berada dalam 
Audio Mixer Window. 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan Audio Mixer 
 
 

6. Setelah itu lakukan perekaman menggunakan tombol Record yang berada di sebelah 

kanan bawah Audio Mixer Window. Kemudian klik Play-Stop Toggle (space). 
 
 
 
 
 

 
Tombol Record  

 
 
 
 

 

Tombol Play-Stop Toggle (space) 
 
 

7. Untuk menghentikan proses perekaman audio caranya klik Record satu kali lagi atau klik 
Play-Stop Toggle (space). 

 
8. Maka hasil perekaman audio akan tampil dalam Timeline Window pada Track Audio 

yang aktif. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan Audio Mixer Window pada saat proses perekaman 



 

 

 
 
 
 
 
 

 

Hasil Audio perekaman pada timeline window 
 
 

 

Efek Audio 

 

Adobe Premiere Pro menyediakan banyak efek audio untuk diaplikasikan pada clip audio, 

diantaranya Balance, Bandpass, Bass, Channel Volume, DeNoiser, Delay, Dynamics, EQ, Fill Left, 

Fill Right, Highpass, Invert, Lowpass, MultibandCompressor, Multitap Delay, Notch, Parametric 

EQ, PitchShifter, Reverb, Swap Channels, Treble, dan Volume. 

 

1. Memberi Efek Audio  
Cara yang paling mudah untuk mengaplikasikan efek adalah dengan : 

 
1. Pilih clip audio yang ada dalam Track Audio di dalam Timeline Window. 

 
2. Kemudian buka Tab Effects yang ada dalam Project Window. Lalu expand pilihan Audio 

Effects 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan Audio Effects pada Tab Effects di dalam Project Window 

 
 

3. Setelah itu pilih sebuah efek audio yang ada di dalamnya, lalu drag efek tersebut dan 

letakkan pada clip audio dalam Timeline Window. 
 

4. Setelah itu buka Tab Effect Controls yang berada dalam Monitor Window untuk 

mengatur parameter efek audio. 



 

 

 
 
 
 
 
 
 
 
 
 
 
 

Tampilan property efek audio dalam Tab Effect Controls 

 
 

5. Untuk menghapus efek audio, pilih efek audio yang tampil dalam Tab Effect Control 
kemudian klik kanan pilih Clear, maka efek audio akan terhapus. 

 
 
2. Menggunakan Efek Equalizer  

Adobe Premiere Pro juga menyediakan equalizer untuk mengatur frekuensi Bass dan Treble 
tetapi dikategorikan sebagai efek audio. Untuk mengaplikasikan efek ini pada clip audio 
caranya : 

 
1. Pilih clip audio yang ada dalam Track Audio di dalam Timeline Window. 

 
2. Kemudian buka Tab Effects yang ada dalam Project Window. Lalu expand pilihan 

Audio Effects. 
 

3. Setelah itu pilih efek audio EQ yang ada di dalamnya, lalu drag efek tersebut dan 

letakkan pada clip audio dalam Timeline Window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Pilihan efek EQ pada Tab Effects dalam Project Window 



 

 

 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan pengaturan equalizer dalam Tab Effect Controls 
 

 

3. Transisi Audio/Crossfade  
Seperti halnya video, clip audio juga dapat diberi transisi. Fungsi dari transisi audio adalah 
membuat perpindahan audio yang halus pada perpindahan clip. Berikut ini langkah-langkah 
untuk memberi transisi pada clip audio : 

 
1. Susun sebuah buah clip video yang memiliki audio dalam Timeline Window. 

 
2. Kemudian susun sebuah clip lagi tetapi buat letaknya overlap dengan clip pertama 

untuk memberikan durasi pada transisi audio. 
 
 
 
 
 
 
 

 

Pengaplikasian transisi audio pada area overlap dalam Track Audio 
 
 

3. Buka tab Effects dalam Project Window, lalu expand pilihan Audio Transition dan 

Crossfade. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tampilan Audio Transition dalam Tab Effects 
 
 

4. Setelah itu pilih efek transisi audio Constant Gain, lalu drag dan drop ke dalam area 

overlap pada Track Audio. 



 

 

 
 
 
 
 
 
 
 
 

 

Pengaplikasian transisi audio pada area overlap dalam Track Audio 
 

5. Kemudian kita dapat melakukan pengaturan efek pada Tab Effect Controls dalam 

Monitor Window. 
 
 
 
 
 
 
 
 
 
 

 

Pengaturan transisi audio dalam Tab Effect Controls 

 
 

Teknik transisi audio sering disebut juga dengan nama Split Edit, yaitu metode untuk 
memotong suatu clip audio, sehingga suara dari clip muncul terlebih dahulu daripada 
videonya (lazim disebut J-cut) atau suara dari clip pertama terus muncul dalam clip kedua 
(lazim disebut L-cut). 

 
 

4. Menghilangkan Noise Audio  
Seringkali pada saat merekam suara/audio suara-suara disekeliling/atmosphere ikut pula 
terekam, termasuk juga noise yang ditimbulkan peralatan elektronik. Untuk menghilangkan 
desis/noise ini digunakan efek Bandpass. Aplikasikan efek audio ini pada clip audio dalam 
Timeline yang terletak dalam Track Audio.  

 
 
 
 
 
 
 
 
 
 
 

 

Letak efek audio Bandpass pada Tab Effects 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Property efek Bandpass yang ada dalam Tab Effect Controls 
 

 

Teknik Keying 

 

Untuk mengganti latar belakang clip digunakan teknik keying, fungsinya untuk membuat 

transparansi, kemudian mengisi area transparan tersebut dengan clip lain. Dalam bahasan ini kita 

akan mengupas berbagai teknik keys diantaranya Green Screen Key, Blue Screen Key, Chroma 

Key, RGB Difference Key, Luma Key, Multiply dan Screen Key. Terkadang dalam skenario terdapat 

adegan yang tidak mungkin dilakukan dengan live shoot, misalnya adegan orang terbang di 

angkasa. Maka untuk mengatasi kendala ini digunakan teknik keying untuk efisiensi biaya. 

Pertama kita harus mengambil gambar talent (misal orang dengan posisi telumgkup seolah-olah 

sedang terbang) dengan background berwarna tertentu (teknik Green Screen memakai warna 

hijau sebagai background). Kedua kita ambil gambar latar belakang yang akan dipakai (misalnya 

gambar langit untuk adegan orang terbang di angkasa). Setelah itu kedua hasil pengambilan 

gambar digabungkan menggunakan teknik superimpose, letakkan gambar talent berbackground 

warna pada layer paling atas, dan gambar langit pada layer dibawahnya. Kemudian aplikasikan 

efek keying (misalnya Green Screen Keying) pada layer yang terletak paling atas. Maka hasilnya 

background berwarna hijau akan digantikan dengan gambar latar belakang langit. 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar talent dengan latar belakang hijau 



 

 

 
 
 
 
 
 
 
 
 
 

Gambar latar belakang berupa langit  
 
 
 
 
 
 
 
 
 
 
 

 

Background hijau yang digantikan latar belakang langit menggunakan teknik Green Screen 
 
 

1. Green Screen Key 
 

Pada teknik Green Screen digunakan background dengan warna RGB (0,255,0) atau warna 
Green-nya 255. Usahakan pada saat pengambilan gambar/shooting digunakan pencahayaan 
(lighting yang merata), sehingga hasil Green Screen akan maksimal. Untuk mengaplikasikan 
teknik Green Screen Key caranya : 

1. Susun clip dengan background langit/space dalam Track Video 1.  
 
 
 
 
 
 
 
 
 
 

Clip bergambar langit sebagai latar belakang 
 

2. Susun clip yang memiliki background warna hijau ke dalam Track Video 2 

(superimpose). 
 
 
 
 
 
 
 
 
 

 
Clip dengan background berwarna hijau 



 

 

3. Buka Tab Effects yang ada dalam Project Window. Expand pilihan Video Effects. 
Expand pilihan Keying. 

 
4. Pilih Green Screen Key, kemudian drag dan letakkan pada clip yang memiliki 

background berwarna hijau. 
 

5. Kemudian atur property efek Green Screen Key yang ada pada Tab Effect Controls di 
dalam Source Monitor Window. Lalu atur parameter Similarity untuk memperbesar 
atau mempersempit range warna. Kemudian atur parameter Smoothing, pilih High 
untuk memperhalus area pinggir gambar sehingga tampak lebih menyatu. 

 
6. Sehingga tampilan akhirnya tampak seperti pada gambar berikut.  

 
 
 
 
 
 
 
 

 

Hasil akhir Green Screen Key 

 
 

2. Blue Screen Key 
 

Pada teknik Blue Screen digunakan background dengan warna RGB (0,0,255) atau warna 
Blue-nya 255. Usahakan pada saat pengambilan gambar/shooting digunakan pencahayaan 
(lighting yang merata), sehingga hasil Blue Screen akan maksimal. Untuk mengaplikasikan 
teknik Blue Screen caranya sama dengan teknik Green Screen diatas, perbedaannya terletak 
pada video efek yang digunakan, pada teknik Blue Screen digunakan efek video Blue Screen 
Key yang terletak pada pilihan Keying pada Video Effects dalam Tab Effect. Kemudian lakukan 
pengaturan efek Blue Screen Key dalam Tab Effect Controls.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Efek Blue Screen Key dalam Tab Effects 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Pengaturan efek Blue Screen Key dalam Tab Effect Controls  

 
 
 
 
 
 
 
 

 

Clip dengan background berwarna biru  
 
 
 
 
 
 
 
 
 
 

Clip bergambar panorama sebagai latar belakang  
 
 
 
 
 
 
 
 
 
 

Hasil akhir teknik Blue Screen menggunakan efek video Blue Screen Key 
 

 

3. Chroma Key 
 

Apabila hasil pengambilan gambar (baik teknik Green Screen maupun Blue Screen) tidak 
sempurna (pencahayaan tidak merata) sehingga terjadi bayangan pada background. Maka 
hal ini dapat diatasi dengan teknik Chroma Key. Setelah diaplikasikan pada clip dengan 
background warna (hijau), lalu atur property Chroma Key yang ada dalam Tab Effect Controls. 
Pada pilihan Color pilih warna background yang akan dihilangkan, kita dapat menggunakan 
tombol eyedropper untuk menunjuk langsung pada clip. Lalu atur Similarity sampai warna 
background tak tampak. 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Letak efek Chroma Key dalam Tab Effects  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Property efek Chroma Key dalam Tab Effect Controls 
 
 
 

4. RGB Difference Key 
 

Untuk background dengan warna-warna selain warna hijau dan biru dapat digunakan efek 
RGB Difference Key. Pilih efek RGB Difference Key lalu aplikasikan efek ini pada clip yang akan 
dihilangkan warna backgroundnya. Kemudian atur property-nya dalam Tab Effect Controls. 
Gunakan parameter Color untuk memilih warna background yang akan dihilangkan. Lalu atur 
pula parameter Similarity sampai warna background hilang. Untuk menghilangkan 
background berwarna putih lebih mudah digunakan efek Luma Key. 
  

 
 
 
 
 
 
 

 

Clip dengan warna background selain hijau dan biru 



 

 

 
 
 
 
 
 
 

 

Clip yang digunakan sebagai latar belakang  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Letak efek RGB Difference Key dalam Tab Effects  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Property efek RGB Difference Key dalam Tab Effect Controls  
 
 
 
 
 
 
 
 
 
 
 
 
 

Hasil akhir pengaplikasian RGB Difference Key 



 

 

5. Image Matte 
 

Kita dapat menggunakan suatu image/gambar untuk menghilangkan area tertentu dari suatu 
clip. Gambar ini disebut dengan Image Matte (Image Mask). Dalam sebuah Image Matte, area 
yang berwarna hitam adalah transparan, sedangkan area yang berwarna putih tidak 
transparan (opaque), dan area yang abu-abu adalah semitransparan. Berikut ini langkahnya 
: 

 

1. Susun sebuah clip video ke dalam Timeline Window.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Tampilan clip dalam Sequence Monitor Window 

 
 

2. Lalu siapkan/buat sebuah gambar hitam putih (dengan format file JPEG, BMP atau 

TIFF) menggunakan tool grafis semacam Adobe Photoshop CS. 
 
 
 
 
 
 
 
 
 
 
 
 

 
Tampilan gambar hitam putih 

 
 

3. Aplikasikan Video Effect > Keying > Image Matte Key yang ada dalam Tab Effects pada 
Project Window ke dalam clip video yang ada di Timeline. 

 
 
 
 
 
 
 
 
 
 
 

 

Letak efek Image Matte dalam Tab Effects 



 

 

4. Lalu buka Tab Effect Controls untuk menampilkan property efek Image Matte.  
 
 
 
 
 
 
 
 

 
Property efek Image Matte Key dalam Tab Effect Controls 

 
 

5. Kemudian klik tombol Setup yang ada dalam property Image Matte Key  yang ada 
pada Tab Effect Controls. Maka akan tampil kotak dialog Select a Matte Image, lalu 

pilih file gambar hitam putih tadi. Kemudian tekan Open. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Kotak dialog Select a Matte Image 
 
 

6. Terakhir rubah pilihan Composite Using ke Matte Luma pada property Image Matte 
Key. Maka hasilnya akan tampak seperti pada gambar di bawah ini. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Hasil Image Matte dalam Sequence Monitor Window 



 

 

 

7. Apabila pilihan Reverse di aktifkan, maka pengaplikasian Image Matte akan terbalik.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Tampilan aktifasi Reverse 

 
 
 

C. TUGAS 

 

Buatlah sebuah video editing yang didalamnya terdapat animasi dan visual effect! 


